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About This Guide

Purpose
This manual describes the ICM-to-ICM Gateway functionality that is part of 
Cisco’s Intelligent Contact Management (ICM) software. It discusses 
ICM-to-ICM Gateway functionality, architecture, and call flows and provides 
step-by-step instructions for configuring ICM systems for ICM-to-ICM Gateway 
use. 

Audience
This manual is intended primarily for system administrators who will be 
responsible for configuring ICM systems for ICM-to-ICM Gateway use. 

Conventions
This manual uses the following conventions.
v
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About This Guide
Organization
Organization
The manual is divided into the following chapters.

Format Example

Boldface type is used for user 
entries, keys, buttons, and folder 
and submenu names.

Choose Edit > Find from the ICM 
Configure menu bar.

Italic type indicates one of the 
following:

• A newly introduced term

• For emphasis

• A generic syntax item that 
you must replace with a 
specific value

• A title of a publication

• A skill group is a collection of agents 
who share similar skills.

• Do not use the numerical naming 
convention that is used in the 
predefined templates (for example, 
persvc01).

• IF (condition, true-value, false-value)

• For more information, see the Cisco 
ICM Software Database Schema 
Handbook.

An arrow ( > ) indicates an item 
from a pull-down menu.

The Save command from the File menu is 
referenced as File > Save.

Chapter Description

Chapter 1, “ICM-to-ICM 
Gateway Overview”

Provides an overview of ICM-to-ICM Gateway 
capabilities, gives examples of possible business 
uses, discusses ICM-to-ICM Gateway links and 
call flows, and states system requirements.

Chapter 2, “ICM-to-ICM 
Gateway Configuration”

Describes the configuration tasks that you need to 
perform on the Client ICM and the Server ICM in 
order to enable ICM-to-ICM Gateway 
functionality.
vi
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About This Guide
Other Publications
Other Publications
For additional information about Cisco Intelligent Contact Management (ICM) 
software, see the Cisco web site listing ICM documentation.

Obtaining Documentation
Cisco provides several ways to obtain documentation, technical assistance, and 
other technical resources. These sections explain how to obtain technical 
information from Cisco Systems.

Cisco.com
You can access the most current Cisco documentation on the World Wide Web at 
this URL:

http://www.cisco.com/univercd/home/home.htm

You can access the Cisco website at this URL:

http://www.cisco.com

International Cisco websites can be accessed from this URL:

http://www.cisco.com/public/countries_languages.shtml

Documentation CD-ROM
Cisco documentation and additional literature are available in a Cisco 
Documentation CD-ROM package, which may have shipped with your product. 
The Documentation CD-ROM is updated regularly and may be more current than 
printed documentation. The CD-ROM package is available as a single unit or 
through an annual or quarterly subscription.

Registered Cisco.com users can order a single Documentation CD-ROM (product 
number DOC-CONDOCCD=) through the Cisco Ordering tool:

http://www.cisco.com/en/US/partner/ordering/ordering_place_order_ordering_t
ool_launch.html
vii
Cisco ICM Software ICM-to-ICM Gateway User Guide Release 6.0(0)

 

http://www.cisco.com/univercd/home/home.htm
http://www.cisco.com
http://www.cisco.com/public/countries_languages.shtml
http://www.cisco.com/en/US/partner/ordering/ordering_place_order_ordering_tool_launch.html
http://www.cisco.com/univercd/cc/td/doc/product/icm/index.htm


 

About This Guide
Obtaining Documentation
All users can order monthly or quarterly subscriptions through the online 
Subscription Store:

http://www.cisco.com/go/subscription

Ordering Documentation
You can find instructions for ordering documentation at this URL:

http://www.cisco.com/univercd/cc/td/doc/es_inpck/pdi.htm

You can order Cisco documentation in these ways:

• Registered Cisco.com users (Cisco direct customers) can order Cisco product 
documentation from the Networking Products MarketPlace:

http://www.cisco.com/en/US/partner/ordering/index.shtml

• Nonregistered Cisco.com users can order documentation through a local 
account representative by calling Cisco Systems Corporate Headquarters 
(California, U.S.A.) at 408 526-7208 or, elsewhere in North America, by 
calling 800 553-NETS (6387). 

Documentation Feedback
You can submit comments electronically on Cisco.com. On the Cisco 
Documentation home page, click Feedback at the top of the page.

You can e-mail your comments to bug-doc@cisco.com.

You can submit comments by using the response card (if present) behind the front 
cover of your document or by writing to the following address:

Cisco Systems
Attn: Customer Document Ordering
170 West Tasman Drive
San Jose, CA 95134-9883

We appreciate your comments.
viii
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Obtaining Technical Assistance
Obtaining Technical Assistance
Cisco provides Cisco.com, which includes the Cisco Technical Assistance Center 
(TAC) website, as a starting point for all technical assistance. Customers and 
partners can obtain online documentation, troubleshooting tips, and sample 
configurations from the Cisco TAC website. Cisco.com registered users have 
complete access to the technical support resources on the Cisco TAC website, 
including TAC tools and utilities. 

Cisco.com
Cisco.com offers a suite of interactive, networked services that let you access 
Cisco information, networking solutions, services, programs, and resources at any 
time, from anywhere in the world. 

Cisco.com provides a broad range of features and services to help you with these 
tasks:

• Streamline business processes and improve productivity 

• Resolve technical issues with online support

• Download and test software packages

• Order Cisco learning materials and merchandise

• Register for online skill assessment, training, and certification programs

To obtain customized information and service, you can self-register on Cisco.com 
at this URL:

http://tools.cisco.com/RPF/register/register.do

Technical Assistance Center
The Cisco TAC is available to all customers who need technical assistance with 
a Cisco product, technology, or solution. Two types of support are available: the 
Cisco TAC website and the Cisco TAC Escalation Center. The type of support 
that you choose depends on the priority of the problem and the conditions stated 
in service contracts, when applicable.
ix
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Obtaining Technical Assistance
We categorize Cisco TAC inquiries according to urgency:

• Priority level 4 (P4)—You need information or assistance concerning Cisco 
product capabilities, product installation, or basic product configuration. 
There is little or no impact to your business operations.

• Priority level 3 (P3)—Operational performance of the network is impaired, 
but most business operations remain functional. You and Cisco are willing to 
commit resources during normal business hours to restore service to 
satisfactory levels.

• Priority level 2 (P2)—Operation of an existing network is severely degraded, 
or significant aspects of your business operations are negatively impacted by 
inadequate performance of Cisco products. You and Cisco will commit 
full-time resources during normal business hours to resolve the situation.

• Priority level 1 (P1)—An existing network is “down,” or there is a critical 
impact to your business operations. You and Cisco will commit all necessary 
resources around the clock to resolve the situation.

Cisco TAC Website

The Cisco TAC website provides online documents and tools to help troubleshoot 
and resolve technical issues with Cisco products and technologies. To access the 
Cisco TAC website, go to this URL:

http://www.cisco.com/tac

All customers, partners, and resellers who have a valid Cisco service contract 
have complete access to the technical support resources on the Cisco TAC 
website. Some services on the Cisco TAC website require a Cisco.com login ID 
and password. If you have a valid service contract but do not have a login ID or 
password, go to this URL to register:

http://tools.cisco.com/RPF/register/register.do

If you are a Cisco.com registered user, and you cannot resolve your technical 
issues by using the Cisco TAC website, you can open a case online at this URL:

http://www.cisco.com/tac/caseopen

If you have Internet access, we recommend that you open P3 and P4 cases online 
so that you can fully describe the situation and attach any necessary files.
x
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Obtaining Additional Publications and Information
Cisco TAC Escalation Center

The Cisco TAC Escalation Center addresses priority level 1 or priority level 2 
issues. These classifications are assigned when severe network degradation 
significantly impacts business operations. When you contact the TAC Escalation 
Center with a P1 or P2 problem, a Cisco TAC engineer automatically opens a 
case.

To obtain a directory of toll-free Cisco TAC telephone numbers for your country, 
go to this URL:

http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml

Before calling, please check with your network operations center to determine the 
Cisco support services to which your company is entitled: for example, 
SMARTnet, SMARTnet Onsite, or Network Supported Accounts (NSA). When 
you call the center, please have available your service agreement number and your 
product serial number.

Obtaining Additional Publications and Information
Information about Cisco products, technologies, and network solutions is 
available from various online and printed sources.

• The Cisco Product Catalog describes the networking products offered by 
Cisco Systems, as well as ordering and customer support services. Access the 
Cisco Product Catalog at this URL:

http://www.cisco.com/en/US/products/products_catalog_links_launch.html

• Cisco Press publishes a wide range of networking publications. Cisco 
suggests these titles for new and experienced users: Internetworking Terms 
and Acronyms Dictionary, Internetworking Technology Handbook, 
Internetworking Troubleshooting Guide, and the Internetworking Design 
Guide. For current Cisco Press titles and other information, go to Cisco Press 
online at this URL:

http://www.ciscopress.com

• Packet magazine is the Cisco quarterly publication that provides the latest 
networking trends, technology breakthroughs, and Cisco products and 
solutions to help industry professionals get the most from their networking 
investment. Included are networking deployment and troubleshooting tips, 
xi
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Obtaining Additional Publications and Information
configuration examples, customer case studies, tutorials and training, 
certification information, and links to numerous in-depth online resources. 
You can access Packet magazine at this URL:

http://www.cisco.com/go/packet

• iQ Magazine is the Cisco bimonthly publication that delivers the latest 
information about Internet business strategies for executives. You can access 
iQ Magazine at this URL:

http://www.cisco.com/go/iqmagazine

• Internet Protocol Journal is a quarterly journal published by Cisco Systems 
for engineering professionals involved in designing, developing, and 
operating public and private internets and intranets. You can access the 
Internet Protocol Journal at this URL:

http://www.cisco.com/en/US/about/ac123/ac147/about_cisco_the_internet_
protocol_journal.html

• Training—Cisco offers world-class networking training. Current offerings in 
network training are listed at this URL:

http://www.cisco.com/en/US/learning/le31/learning_recommended_training
_list.html
xii
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C H A P T E R 1

ICM-to-ICM Gateway Overview

This chapter provides an overview of ICM-to-ICM Gateway. It discusses the 
following topics:

• Business uses for ICM-to-ICM Gateway 

• The ICM-to-ICM Gateway link

• ICM-to-ICM Gateway call flows 

• ICM-to-ICM Gateway fault tolerance capabilities

• ICM-to-ICM Gateway system and network configuration requirements

What is ICM-to-ICM Gateway?
ICM-to-ICM Gateway extends the ICM software capability by allowing agents to 
simultaneously post-route calls and supply additional call-related information to 
a second agent on a different ICM. This enables the initial agent to pass on 
gathered information without the customer’s needing to repeat it to the second 
agent. 

Following are some business scenarios where ICM-to-ICM Gateway functionality 
can be particularly useful. 

• A customer calls the institutional department of a financial corporation for 
customer service assistance with a company-sponsored 401k. The customer 
then asks to be transferred to the retail department to obtain assistance with a 
personal account.
1-1
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ICM-to-ICM Gateway Call Flow
• Two corporations (for example, a bank and an insurance company), each of 
which has a contact center that uses an ICM, merge. It may often be desirable 
to transfer a call between the two companies; for example, to sell insurance 
to a bank customer.

• A customer calls a hotel to make a reservation. The hotel agent then asks the 
customer if he/she also needs to rent a car, and then transfers the customer to 
a car rental agent.

• A company uses an outsourcer to handle part of its overflow traffic. For 
example, the company service department handles paid support calls in-house 
but transfers warranty service requests to the outsourcer.

• A multi-national corporation encompasses several geographic regions; each 
geographic region has its own ICM.

In all these cases, ICM-to-ICM Gateway enables the call-related data to be 
transferred along with the call so the customer does not need to supply this 
information again. 

ICM-to-ICM Gateway Call Flow
Figure 1-1 illustrates basic ICM-to-ICM Gateway call flow. 

Figure 1-1 Basic ICM-to-ICM Gateway Call Flow
1-2
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ICM-to-ICM Gateway Call Flow
Step 1 A Client ICM receives a request. This could be a pre-route request from a service 
provider network (in which case the routing client is a NIC) or a post-route 
request from an ACD/IVR (in which case the PG acts as the routing client)

Step 2 The Client ICM executes a script. At some point the script initiates a route request 
to the other ICM, referred to as the Server ICM. At this point the Server ICM must 
find a destination label for the call.

Step 3 The Server ICM executes a script to select a destination label for the call. The 
Server ICM handles this call as a normal route request, save for the fact that the 
routing client is another ICM and not a service provider network or an ACD/IVR. 
Once a destination label is selected the Server ICM sends it back to the Client 
ICM.

Step 4 When the Client ICM receives the destination label from the Server ICM, it passes 
the label directly to the routing client that initiated the route request. This does 
not happen under script control, but is an automatic process.

ICM-to-ICM Communication
The ICM-to-ICM Gateway link connects two ICMs through a Cisco proprietary 
protocol called INCRP (Intelligent Network Call Routing Protocol). Both ICMs 
have a component managing the connection.

The component on the Client ICM is called an ICM Gateway. It sends the route 
requests and receives the responses (destination labels) from the Server ICM.

The component on the Server ICM is called an INCRP Network Interface 
Controller (INCRP NIC). The NIC receives route requests and sends responses 
back to the requester. An ICM can have an INCRP NIC, as well as other types of 
NICs.

Both the ICM Gateway and the INCRP NIC are components that run on the Router 
machine, so no additional hardware is required. 
1-3
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ICM-to-ICM Gateway Call Flow
Figure 1-2 ICM-to-ICM Link Components

The ICM-to-ICM link shown in Figure 1-2 is a connection in one direction only. 
It allows the Client ICM to send route requests to the Server ICM, but not the 
other way around. It is possible to additionally reverse the roles of the ICMs as 
well, so that each ICM can send route requests to each other. In this case, each 
ICM needs an ICM Gateway and an INCRP NIC, as shown in Figure 1-3. 

Figure 1-3 Bi-Directional ICM-to-ICM Link

INCRP supports direct connections between two ICMs only. ICMs that are not 
directly connected with an ICM-to-ICM link cannot send each other route 
requests through another ICM. 
1-4
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Pre-Routing
Figure 1-4 illustrates a call flow scenario for a call that is pre-routed from one 
ICM to another. 

Figure 1-4 Example Pre-Routing Call Flow

Step 1 The Service Provider network sends a route request to the Client ICM.

Step 2 The Client ICM receives the pre-route request and executes a routing script that 
determines that the route request should be handed to another ICM. The ICM 
forwards the route request to the Server ICM.

Step 3 The Server ICM executes a script that selects a peripheral target for the call and 
sends the corresponding label back to the Client ICM.

Step 4 If the selected target is reached using a translation route, the Server ICM sends the 
call context data to the selected peripheral, where it waits for the call to arrive. If 
translation routing is not used, this step is skipped.

Step 5 The Client ICM receives the destination label from the Server ICM and forwards 
it to the network.

Step 6 The network connects the call to the selected destination on the Server ICM 
ACD/Agent.
1-5
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ICM-to-ICM Gateway Call Flow
Step 7 If this was a translation routed call, the ACD connected to the Server ICM 
requests the call detail information from the PG where it has been waiting since 
Step 4 and sends the call to an agent.

Post-Routing
Figure 1-5 illustrates a call flow scenario for a post-routed call transfer from one 
ICM to another. 

Figure 1-5 Example Post-Routing Call Flow

Step 1 A call terminates at an ACD that is connected to the Client ICM. This can be a 
pre-routed call or a call sent there without ICM control.

Step 2 The agent initiates a post-route request in one of two ways:

a. The agent transfers the call to a special number on the ACD, which prompts 
the ACD to issue a post-route request to the ICM.

b. The agent sends a call transfer request to the CTI Server (not shown). This 
transfer request should have the post-route flag set, so that a post-route 
request is issued to the ICM before transferring the call.
1-6
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Logical Connection Management and Fault Tolerance
Step 3 The Client ICM receives the post-route request along with the call context and 
runs a scheduled script for that call type. 

Step 4 The Server ICM selects a destination for the call and responds back to the Client 
ICM with the selected label. The Server ICM also returns the (possibly modified) 
call context to the Client ICM. 

Step 5 The Client ICM receives the label, attempts to validate it, and passes the label 
onto its routing client. If no label is received from the Server ICM (or the Server 
ICM is not online) the Client ICM provides a destination label and sends it to the 
routing client. 

Step 6 If the selected target was a peripheral target with an associated translation route, 
the Server ICM sends the translation route information to the PG, where the ACD 
waits until the call arrives at the ACD and the ACD retrieves the information from 
the PG (in step 7). If the selected target does not use a translation route, this step 
is skipped. In that case, the call context is still transferred to the Server ICM but 
it is not available for the receiving ACD, since it cannot be matched with the call.

Step 7 The original PG and the ACD transfer the call to its destination. The PG sends the 
destination label to the ACD. The ACD uses that information to disconnect the 
agent who requested the call transfer and connects the incoming call leg to its 
destination using a tie line or public network trunk.

Step 8 The ACD connected to the Server ICM receives the call, requests the call detail 
information from the PG if applicable, and sends the call to an agent.

Logical Connection Management and Fault Tolerance
Because the ICM software is typically deployed as a synchronous duplex pair, the 
ICM-to-ICM Gateway is likewise deployed between ICM system pairs. This 
leverages the ICM software’s fault tolerant architecture and keeps the 
synchronous router pairs in sync. 

ICM-to-ICM Gateway addresses the following other possible points of failure as 
follows:

• In the case of a link failure, each INCRP NIC has a link to both ICM Gateway 
components. Each INCRP NIC can therefore maintain communications with 
the other ICM Gateway.
1-7
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• If an INCRP NIC fails, the Client ICM’s routers are synchronized and can 
communicate via the remaining INCRP NIC. 
1-8
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ICM-to-ICM Gateway Requirements
Note If a link failure or a NIC failure occurs, calls that were in progress at the time of 
the failure may be lost.

• If an ICM-to-ICM Gateway fails, the Server ICM’s routers are synchronized 
and can communicate via the remaining ICM-to-ICM Gateway.

For a full explanation of ICM Fault Tolerance, see the Cisco ICM Enterprise 
Edition Administration Guide.

ICM-to-ICM Gateway Requirements
 The following are system requirements for ICM-to-ICM Gateway.

• Both Client ICM and Server ICM require ICM software version 4.5.1 or later. 
If two connected ICMs are running different versions of ICM software, only 
the ICM-to-ICM Gateway features supported by the lowest numbered version 
are available.
1-9
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• An ICM communication network configuration that can support ICM-to-ICM 
Gateway. The Signaling Access Network (SAN) is strongly recommended, 
with the private network as an alternate if a SAN does not exist. 

Note See the Cisco ICM Enterprise Edition Pre-installation Planning: 
Guide for information about the Signaling Access Network and ICM 
communications network configurations.
1-10
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C H A P T E R 2

ICM-to-ICM Gateway Configuration 

This chapter includes instructions for the various tasks that you need to perform 
on the client and server systems in order for ICM-to-ICM Gateway to function 
correctly. For the Client ICM, these tasks include the following:

• Configuring an ICM Gateway process on the Router. 

• Define Client ICM configuration data.

• Making the necessary script changes for sending pre-route or post-route 
requests to the Server ICM.

• Optionally, specifying a fixed local port number for the Network CIC 
process.

•

For the Server ICM, these tasks include the following:

• Installing and Configuring an INCRP NIC on the Router.

• Setting up the necessary translation route labels.

• Making the necessary script changes for returning calls and labels to the 
Client ICM.

Note If you are implementing a bidirectional ICM-to-ICM Gateway link (see 
Chapter 1, “ICM-to-ICM Gateway Overview”), you need to perform Client side 
configuration and Server side configuration on both ICM systems.
2-1
CM Gateway User Guide Release 6.0(0)



 

Chapter 2      ICM-to-ICM Gateway Configuration
Client ICM Configuration
Client ICM Configuration
This section provides instructions for the configuration tasks you need to perform 
on the Client ICM.

Identify the Client for the Server
To identify the ICM Gateway Client for the ICM Gateway Server, run a full ICM 
Setup on the Client Router machine. For each ICM-to-ICM Gateway client, you 
must perform the following steps.

Step 1 In the Router Properties screen, check the Remote Network Routing option box.

Step 2 Specify a NAM ID (Client ICM ID) number in the NAM ID box provided. 
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• If this Client ICM is the only Client ICM that will be communicating with its 
associated Server ICM, accept the default of 0. 

• If the associated Server ICM will be communicating with multiple Client 
ICMs, the NAM ID needs to be a unique number for each Client ICM in the 
configuration. In this case, it is recommended that you start NAM ID numbers 
from 0 and work upwards.

Note Make a note of the NAM ID number that you specify for the client. You will need 
to specify this same NAM ID number during Server side configuration.

For more information on router installation, see the Cisco ICM Enterprise Edition 
Installation Guide.

Defining Client ICM Configuration Data
In a two-tier architecture, the Client ICM system requires only a subset of the 
normal ICM configuration data. Table 2-1 summarizes the configuration data for 
a Client ICM.

Table 2-1 Configuration Data on a Client ICM

Table Contents

Announcement Any announcements used in Client ICM scripts.

Application Gateway A remote ICM gateway for each instance on each 
associated Server ICM.

Business Entity The default business entity only.

Call Type Typically, one for each instance.

Call Type Map Associate each Client ICM call type with a Client 
ICM script.

Dialed Number All dialed numbers used on associated Server 
ICMs, plus those used for direct translation. (No 
default routes are defined for Client ICM dialed 
numbers.)
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The Client ICM needs only a limited configuration (dialed numbers, labels, basic 
routing scripts, etc.) while the instance-specific scripts, configuration, real-time, 
and historical data are stored on the Server ICM.

To set up your Client ICM configuration, run Configuration Manager on a Client 
ICM Admin Workstation. 

For instructions on using Configuration Manager, see the Cisco ICM Enterprise 
Edition Configuration Guide.

Create or Configure the Gateway Process on the Router
An Application Gateway process must be configured on the Client ICM for each 
Server ICM that the Client ICM is going to communicate with.

Dialed Number Map Associates dialed numbers and calling line IDs with 
Client ICM call types.

Label All labels that can be returned by associated Server 
ICMs, plus those used for direct translation.

Network Interface 
Controller

One required for the Network Interface Controller 
to the carrier network.

Peripheral Gateway (PG) One or more for the Peripheral Gateway to the 
carrier network.

Prefix Any prefixes used in Client ICM regions.

Region Any regions used in Client ICM dialed number 
map.

Routing Client One or more for the carrier network.

Script One or more for each call type.

Table 2-1 Configuration Data on a Client ICM

Table Contents
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Configuring A New Gateway

If you need to configure a new Application Gateway, perform the following steps.

Step 1 From the ICM Configuration Manager on an Admin Workstation associated with 
the Client ICM, select Calls > Application Gateway > Application Gateway 
List. The Application Gateway List window appears.

Step 2 Click Retrieve.

Step 3 Click Add. The Attributes tab appears.
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Step 4 Specify the following values on the Attributes tab:

• Name. Enter a name for the ICM Gateway.

• Type. Choose Remote ICM.

• Preferred Side. Indicates the preferred side of the Gateway to use when both 
are available. If only one side is available, ICM software uses that side 
regardless of preference. 

• Encryption. Indicates whether requests to the Application Gateway are 
encrypted. Choose None.

• Fault Tolerance. If the Application Gateway is duplexed, specifies the 
fault-tolerance strategy it uses. Choose None.

• Connection. Choose whether the Gateway is Duplex (has both a Side and 
Side B connection), Simplex A (only has a Side A), or Simplex B (only has a 
Side B).

• Description. (Optional.) Additional information about the gateway.

Step 5 Click the Save button to create the gateway.

Note Make a note of the Application Gateway ID value, as you will need it 
when you run Setup to configure the INCRP NIC on the Server ICM.

Step 6 To set the connection information, click on the Connection Side A tab or the 
Connection Side B tab.

Step 7 To specify an address, click on the Enter Address button. The Enter NAM 
Addresses dialog box appears.
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Step 8 Specify the following information:

• NAM Mode. Select Single NAM.

• IP Address/Name. Enter the high priority IP address of the Server ICM. 
(Normally this is the public IP address, but if no public address is available, 
use the high priority private IP address.) This address must be the same 
address specified for the INCRP NIC on the targeted system. (You may use 
the hostname in place of the address.) 

• Instance Number. Enter the number of the customer ICM on the Server ICM 
(0 through 24).

• Side. Indicate which side of the Client ICM prefers this connection:

– Side A. Client ICM Side A prefers to use this connection.

– Side B. Client ICM Side B prefers to use this connection.

– None. Neither side of the Client ICM prefers to use this connection.
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– Both Side A and B. Both sides of the Client ICM prefer to use this 
connection.

Note Consider network traffic in choosing this value. For example, if one side 
of the Client ICM is co-located with only one side of the Server ICM, you 
can make that the preferred connection in order to avoid unnecessary 
WAN traffic to the other side.

Step 9 When finished, click Save to save the changes.

The bottom half of the ConnectionSide A and Connection Side B tabs display a 
number of timeout and limit values. Accept the defaults for these values.

Configuring an Existing Gateway

If the gateway process is already present on the Router, perform the following 
steps to configure it for ICM-to-ICM Gateway use.

Step 1 Bring up the Calls > Application Gateway > Application Gateway List screen. 
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Step 2 Click Retrieve.

Step 3 From the Application Gateway list, make note of the Application Gateway IDs 
number(s) for the server system(s). You will need to specify these Application 
Gateway ID number(s) during Server side configuration.

Step 4 Configure the Connection Side A and Connection Side B tabs as needed. See the 
Cisco ICM/IP Contact Center Software Enterprise Edition Scripting and Media 
Routing Guide for instructions.

Step 5 Bring up the Enterprise > System Information Screen. 
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Step 6 In the Application Gateway section, click on Remote ICM. Accept the default 
values for the remaining fields on all tabs.

Configuring ICM Instances on the Client ICM
Perform the following steps on the Client ICM system to configure the associated 
Server ICM instance.

Step 1 Start Configuration Manager from the ICM Admin Workstation group. The 
Configuration Manager window opens.

Step 2 Open the ICM Instance List tool (Enterprise > ICM Instance > ICM Instance 
Explorer). The ICM Instance List window appears.

Step 3 Click the Retrieve button.

Step 4 Click the Add ICM Instance button.
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Step 5 Specify the following on the ICM Instance tab:

• Name. The enterprise name for the Client ICM instance, as used in Setup. 

• Type. (Drop-down list.) Select Network ICM. 

• Instance Number. The instance number as defined in Setup.

• Description. (Optional.) Additional information about the ICM Instance.

Step 6 Click Save. 
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Step 7 Click the Add ICM Instance button.

Step 8 Specify the following on the ICM Instance tab:

• Name. The enterprise name for the Server ICM instance, as used in Setup. 

• Type. (Drop-down list.) Select Customer ICM. 

• Instance Number. The instance number as defined in Setup.

• Network ICM Instance. (Drop-down list.) The associated Client ICM 
instance configured in Step 5.

• Description. (Optional.) Additional information about the ICM Instance.

Step 9 Click Save. 

Client Script
Typically, the client ICM originally receives the call and pre-routes it to an ACD. 
The call is then post-routed to a peripheral associated with the server system. The 
client determines the label associated with the server’s peripheral by requesting 
the label from an ICM Gateway node in a script.

From the Script Editor, you can specify a local definition of the label that the ICM 
Gateway node returns. Perform the following steps:

Step 1 Right click on the ICM Gateway node. 

Step 2 From the pop-up menu that appears, choose Properties. The ICM Gateway dialog 
box appears.
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Step 3 From the list, select the gateway to the ICM system to which you want to send the 
request.

Step 4 Check the Validate Returned Labels check box if you want the Client ICM to 
validate the label that the Server ICM returns before passing it to the routing 
client. If the Server ICM is returning a dynamic label (an expression the Server 
ICM CallRouter converts to a character string and returns to the routing client as 
a label), do not check this box.

Step 5 On the Default Label tab, specify a default label to be used if the Server ICM 
returns an invalid label.

Step 6 Click OK.
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Specifying a Fixed Local Port Number for the NetwrkCIC Process
In an ICM to ICM Gateway implementation, the NetwrkCIC process is a part of 
the Client ICM Router installation that manages the ICM Gateway. By default, the 
IP port used in the NetwrkCIC process for the public network communication to 
the Server ICM INCRP NIC process is selected dynamically at runtime. 

ICM processes use IP port numbers between 39000 and 50000. If the NetwrkCIC 
port number selected is in this range, use the following formula to obtain the 
number for side A of a duplexed system

Port number = 40000 + (i * 40) + 33

where i is the instance number of an ICM instance. To find out the instance 
number, run the local setup program, select an instance and click the edit button. 
The “Edit Instance” dialog box will display the instance number. 

For instance number 0, the port number will be 40033. 

For side B, the port number is obtained by adding 1000 to the above number. This 
formula is intended to be stable. However, there is no guarantee that the formula 
will not change.

This dynamic port allocation is an issue for some ICM customers. You can 
optionally modify the NetwrkCIC process to use a specific port number. If a 
specific port number is provided in the registry of the Client ICM machine, the 
NetwrkCIC process will instead bind to that port number when communicating 
with the server INCRP NIC process. 

To specify this port number, add the following registry entry on the Client ICM 
machine:

HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems, Inc.\ICM\<instance 
name>\Router[A,B]\CIC\CurrentVersion\Configuration\CIC Public LAN IP 
Port

Specify this entry as a DWORD type. 

This registry entry is not managed by the ICM Setup program. Therefore if you 
upgrade  ICM software later, you must add the registry entry again.

If the registry entry is not present, the NetwrkCIC process uses the port 
dynamically allocated as usual. 

If you change the port number while the NetwrkCIC process is running, you must 
restart the ICM router service for it to take effect.
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Server Configuration
This section provides instructions for the configuration tasks you need to perform 
on the Server ICM.

Defining and Configuring the INCRP NIC
To set up the INCRP NIC for each instance on the Server ICM, you must perform 
the following tasks:

• Install the INCRP NIC, if you have not already done so

• Define the INCRP NIC using the NIC Explorer tool

• Add INCRP NIC information using ICM Setup

Installing the INCRP NIC

If you need to install the INCRP NIC, see the Cisco ICM Enterprise Edition 
Installation Guide for guidelines and procedures. Depending on your network 
interface, you may need to perform the following additional tasks:

• Set up the NICs in Setup’s Device Management Protocol Properties 
dialog box. 

• Enable a DMP device on the Server ICM for each physical controller 
(A through H). 

How to Define the INCRP NIC

Step 1 Within the ICM Admin Workstation group, double-click AW Select. The Select 
ICM AW Service window appears.

Step 2 Select the instance you will be configuring.

Step 3 From the ICM Configuration Manager, invoke the NIC Explorer tool. The NIC 
Explorer window appears.

Step 4 In the Select filter data box, click Retrieve. This enables the Add NIC button.

Step 5 Click Add NIC. A new NIC and its routing client display in the tree window. Next 
to each is a To Be Inserted icon. 
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On the right of the tree window, tabbed fields also display the new NIC’s and 
routing client’s configuration information.

Step 6 Enter the following in the Logical Interface Controller tab fields:

• Name. A name that will serve as the NIC name. The name can be up to 32 
characters. The valid characters are upper-case and lower-case letters, digits, 
periods (.) and underlines (_). The first character of the name must be a letter 
or digit.

• Client Type.(Drop-down list.) The type of routing client serviced by the 
NIC. Select INCRP.

Note Selecting a type of routing client automatically places that type’s 
default values in the Routing Client’s Timeout Threshold, Late 
Threshold, Timeout Limit, Use DN/Label Map, and Client Type 
fields.

Step 7 Click the Add Physical Interface Controller button. The Physical Interface 
Controller dialog box appears.
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Step 8 In the Create Single Physical Interface Controller section, specify an Enterprise 
Name and, optionally, a Description.

Step 9 Click OK. The Physical Interface Controller tab appears, displaying the 
information you specified, and an ID value of UNASSIGNED.

Step 10 Enter the following information in the Routing Client tab fields:

• Name. A name that will serve as the NIC Routing Client name. The name can 
be up to 32 characters. The valid characters are upper-case and lower-case 
letters, digits, periods (.) and underlines (_). The first character of the name 
must be a letter or digit.

• Timeout threshold. The maximum time, in milliseconds, the routing client 
can wait for a response to a routing request. The NIC sends a default response 
slightly before this threshold.

• Late threshold. A threshold value, in milliseconds, for classifying responses 
as late. Any response that exceeds this threshold is considered late even if it 
does not exceed the Timeout Threshold.

• Timeout limit. The maximum time, in seconds, for which the routing client 
waits for a response. This is the maximum time the routing client will tolerate 
consecutive response timeouts before it stops sending requests to the ICM 
software. If the routing client receives no responses from the ICM software 
within this limit, it terminates routing operation.
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• Client Type.(Drop-down list.) The type of routing client that ultimately 
routes the call on the requesting ICM system. This should match the type of 
NIC running on the Client ICM.

Step 11 Click Save. The newly defined NIC is saved in the database, a Physical Controller 
ID is assigned, and the To Be Inserted icon is removed from the tree window.

Note Make a note of the Physical Controller ID value. You need this value 
to set up the INCRP NIC on the CallRouter. If the NIC is duplexed, 
you need both Physical Controller ID values.

Step 12 Click Close to exit the NIC Explorer.
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Configuring the INCRP NIC in ICM Setup

To configure the INCRP NIC on the Server ICM, run ICM Setup and edit the 
Router from the Server Router machine (rather than from the installation CD). 
Perform the following steps.

Step 1 On the Router Component Properties screen, click the INCRP check box.

Step 2 Click on the Configure button. The INCRP NIC Properties screen appears.
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ICM Setup supports a maximum of ten clients. 

Step 3 In the Network Interface Controller section of this screen, ensure that the value 
for Physical Controller matches the Physical Controller ID value that was 
assigned to the NIC when you defined the NIC (see the previous section, 
“Installing the INCRP NIC”).

Step 4 In the Client ICM section of this screen, enter the following information for each 
client for which this system is a server.

• Enable. Check the Enable box to enable the client.

• Description. Enter a description of the client (optional).

• Client ID. Enter the same value that you entered for NAM ID during client 
machine router setup on the Router Properties screen (see the section entitled 
“Identify the Client for the Server”). 
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• Application Gateway ID. Enter the application gateway ID. This must 
match the application gateway ID as shown on the Calls > Application 
Gateway All list screen (see the section entitled “Create or Configure the 
Gateway Process on the Router”).

• Side A Address, Side B Address. If you are using the Signaling Access 
Network, enter the Signaling Access Network IP address for the client. 
Otherwise, enter the Public Network IP address.

Step 5 Click OK.

Setting Up Translation Route Labels
From the ICM-to-ICM Gateway server’s point of view it is doing a translation 
route to one of its peripheral targets. When you set up a translation route on the 
Server ICM, you must set up a label for the original routing client for a call to 
access each of the peripheral targets associated with the translation route. For 
example, if the routing client is an interexchange carrier (IXC), you must set up a 
label to the targets with the IXC. This allows the call to be initially sent to the 
translation route at the peripheral. 

For instructions on how to run Translation Route Wizard and how to define 
translation route labels, see the Cisco ICM Enterprise Edition Configuration 
Guide.

Modifying Routing Scripts
The server has a script that handles requests from the client. The script is 
associated with a call type, which is in turn defined by the dialed number, calling 
line id, and caller entered digits. 

From the Script Editor, you can specify the label that the server script returns to 
the client. For example, you could create a Select node that routes calls to 
specified services under certain conditions. Perform the following steps.

Step 1 From Script Editor, connect the Select node to a Service node.

Step 2 Right click on the Select node and choose Properties. The dialog box appears.
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Step 3 Specify the criteria for selecting services. 

Note You can specify the label that the server script returns from other Script Editor 
nodes, such as the Label node. See the Cisco ICM/IP Contact Center Software 
Enterprise Edition Scripting and Media Routing Guide for more information.
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